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4 Introduction 

FRIWO Gerätebau GmbH (further abbreviated as “FRIWO”) is a manufacturer of electronic 
devices such as power supply units, motor control units, and battery packs. This 
document is a reference manual for the Enable-Tool, a piece of software that allows 
monitoring, calibration, and configuration of motor control units and battery management 
systems (integral part of the battery pack). The following pages are aimed at explaining 
how to use the Enable-Tool safely and responsible, to achieve your goals. 

5 Copyright 

The content of this document is protected and owned by FRIWO and may not be used, not 
even in part, for own publications and implementations. Exception shall only be permitted 
after the prior written approval from FRIWO. 

6 Liability Waiver and terms of use 

Using the motor control unit referenced in this document can be dangerous in case of 
incorrect use. Therefore, it is mandatory to follow instructions in this manual carefully. 
Stop your application work if you encounter unexpected behavior. 

6.1 Terms of use 

The use of this program, further called “Enable-Tool” or „Software“, can be very 
dangerous, that means it can cause damage to persons and property in case of incorrect 
use. Use the Enable-Tool with extreme care and make sure that you follow the 
instructions in this manual and that it is used by qualified personnel only. With this 
Software, you are able to influence or control a connected electronic control system such 
as motor-controllers, battery-management-units or other general electronic control 
devices. Your actions may result in serious personal injury or property damage. Therefore, 
you should only use this software (i) if you understand the possible consequences which 
might occur by working with this Software and (ii) if you have been specifically 
trained/qualified to work with this software! The Enable-Tool is currently under 
development and the functionality might be subject to change without prior notice or 
arrangement. 

FRIWO   ENABLE TOOL

 5/60



 

Enable-Tool 
Manual 

 

 

15.12.2021  6|60 

 

Confidential 

6.2 Liability Waiver 

This Liability Waiver (further called “waiver”) is made between the parties FRIWO 
Gerätebau GmbH (“Manufacturer”) Von-Liebig-Strasse 11, 48326 Ostbevern and the user 
of Enable-Tool (“User”). For purposes of this waiver, the definitions of the parties shall be 
deemed to include any parent, subsidiary, affiliate of, or entity under common control. 

6.2.1 Purpose 

User desires to get access to the online-network infrastructure of the Manufacturer to 
obtain a license for the use of the Enable-Tool. User desires to use Enable-Tool to work 
with one or more electronic-control-units of the Manufacturer. The parties acknowledge 
that advanced electronic-control-units are complex and proprietary devices that require 
special knowledge, skills and equipment to program and commission. User declares that 
he complies with the instructions in the manual and that he has all necessary knowledge, 
skills and equipment to work with it. 

6.2.2 Non-Exclusivity 

The waiver does not prevent either party from continuing its independent, continuous 
development of technologies, products and other business-related research and 
development. 

6.2.3 General 

If any provision of the waiver is held invalid or unenforceable by a court of competent 
jurisdiction, such invalidity or unenforceability will not affect any other provision of the 
waiver, which shall remain in effect. 

6.2.4 Governing Law 

This waiver is subject to the law of the Federal Republic of Germany with the exclusion of 
the conflict-of-laws rules and with the exclusion of the United Nations Convention on 
Contracts for International Sale of Goods (CISG). The place of jurisdiction for all disputes 
arising out of this waiver is Münster, Westfalen. 
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6.2.5 Entire waiver 

This waiver constitutes the entire agreement between the parties with respect to the 
subject matter herein, and supersedes all prior oral or written waivers, arrangements, and 
understandings related thereto. This waiver may not be modified or amended except in 
writing signed by an authorized representative of each Party. WHEREOF, in consideration 
for the mutual promises contained herein, the parties have caused this waiver to be 
executed by their authorized representatives. FRIWO Gerätebau GmbH assumes no 
liability for loss of data, personal injury or damage of property caused by misuse of the 
program or by use of improper settings. In particular, we expressly point out that FRIWO 
Gerätebau GmbH under no circumstances warrant / is liable for, including but not limited 
to, data loss, personal injury or property damage resulting from the direct use of this 
software takes over. This does not apply if liability is based on: (i) the German Product 
Liability Act („Produkthaftungsgesetz“) or comparable foreign laws; (ii) intent; (iii) gross 
negligence on the part of the owners, legal representatives or executives; (iv) fraud; (v) 
failure to comply with a guarantee granted; (vi) negligent injury to life, limb or death; or 
(vii) negligent breach of a fundamental condition of contract. However, claims for 
damages arising from a breach of a fundamental condition of contract shall be limited to 
the foreseeable damage which is intrinsic to the contract, provided that no other of the 
above cases applies. 
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7 Installation 

Before installing the Enable-Tool, it should be checked that the system meets the 
following requirements. 

• Operating System: Windows 10 
• CPU: Intel i3 4. GEN or comparable / better 
• RAM: 4 GB 
• Storage: 10 GB free space 
• Interface: USB 2.0 hi-speed or better 
• A working internet connection 

The latest installer for the Enable-Tool can be downloaded from the FRIWO web shop. 
The download is a ZIP file which contains the Enable-Tool and a setup.exe file. After 
downloading the ZIP file, its contents have to be extracted before executing setup.exe. 
The installation requires administrative privileges. 
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Figure 1: example license request 

After the installation is complete the Enable Tool can be launched from the desktop or the 
start menu. Depending on the system, the tool might initiate an additional driver 
installation. If this is the first time the Enable-Tool is started on this computer you will be 
prompted for a license. Fill out the license request as shown in the example. Processing 
this request requires a few minutes, please wait for the confirmation E-mail, before 
restarting the Enable-Tool. The computer will then be permanently linked to the license, 
which prohibits it from being used on any other device.  
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The project code in the form is an identifier used in our web shop. It resembles a pool of 
licenses that is representative of a project (i.e. a certain product line). The project code 
comes with the license that was purchased. Developers that want to use the Enable-Tool 
should contact their project managers or lead developers. Licenses can be bought and 
registered to the pool as needed. First time customers will receive a project code upon 
their first purchase. For more information on obtaining a license see chapter 15 Licensing, 
or visit our web shop. 

  
https://www.friwo-shop.de/
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8 General Information 

FRIWO Enable-Tool is a measurement and calibration software for parameterization of 
motor controls and battery management systems. The software establishes an encrypted 
connection to an ECU via the USB interface, and allows read and write access to 
parameters and measured values. The Enable-Tool is typically used for the following 
purposes. 

8.1 Customer Service / Production 
• Firmware and dataset update 
• Troubleshooting (error memory evaluation, diagnostic functions) 
• Service routines (e.g. training of a throttle grip and brake contact switch) 
• Preparation of a vehicle for handover to the end customer 
• Maintenance of a vehicle 

8.2 Development 
• Parameterization (setting of ECU functions) 
• Dataset handling: read, write, sign, compare, mix 
• Sharing of dataset in development teams 
• Log function 

8.3 Production 
• Write production dataset 
• Preparation of a vehicle for delivery 
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8.4 Important notes on setting parameters 

Setting parameters can have negative effects on the behavior of the 
controller. Please review the following notes on setting or adjusting 
parameters. 

• Only start working with the Enable-Tool after reading this document and 
understanding its content.  

• Apply changes to the parameters gradually step by step. 
• Great care was attached to safety during the development of the software Invalid 

changes should be intercepted and parameters should be limited to safe values. 
• However, a residual risk cannot be ruled out with certain changes. It is therefore 

recommended that you only change parameters when the system to be controlled is 
idle. In addition, you should always use a USB isolator to protect your PC from 
possible over voltages and to prevent ground loops in your laboratory or test bench. 

• Some parameters are monitored by superimposed protective functions, so that only 
limited changes are possible during operation. 
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8.5 Nomenclature (Parameters and snapshots) 

The naming convention for Variables is as follows: 

 

Figure 2: naming convention for parameters 

Parameters and measured values can be adjusted or measured with the Enable-Tool. 
Read the appropriate instructions before using the Enable-Tool. The graphical user 
interface is very customer-specific and can vary depending on the customer, application 
and user authorization. It is therefore possible that not all parameters, measured values 
and functions described in this document are available to you. 

A snapshot contains the current values of all parameters of the ECU, during firmware 
updates a snapshot is temporarily created in order to restore the ECU to the last known 
state. There are fail-safes in place to restore the snapshot even if the update fails. 
However, we strongly recommend creating snapshots for backups, so that data can be 
restored in case of data loss. Snapshots can also be used to configure new ECUs in 
production. More on snapshots and how to create them can be found in the chapter 11.5 
Snapshots. 
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9 Quick start 

After connecting the motor controller or electronic control unit to your computer via USB 
(for alternative methods see the chapter13 Connect via CAN), you can scan for it in the 
Enable-Tool. To do so press the start button in the upper left corner and select Scan…, or 
press Ctrl + S. The application will now spawn a new ECU overview window for each 
device that was found. The window consists of five major elements. The menu bar is on 
top. Just below the menu bar to the left is a general overview labeled ECU, which contains 
information about the Hardware and Software in use, as well as an indicator for the 
connectivity to the ECU. In the middle is the live view, which can show real-time data sent 
by the ECU. At the bottom left is a plot window, which supports the live view by visualizing 
its listed parameters (for more information see chapter 11.2 Live View). To the right hand 
side is the variable view. All available variables that can be set or read can be seen here. 
The User Interface is described in detail in chapter 10 GUI Overview. After establishing a 
connection, the Enable-Tool will download the necessary data containing further 
information about the connected device. From here on out you can work with your ECU 
and the Enable-Tool, tweak and monitor parameters to your liking. 
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10 GUI Overview 

Figure 3 shows the Graphical User Interface (GUI) of the Enable-Tool. It consists of several 
elements, which are briefly described in Table 1 down below and extensively in the 
following chapters. 

 

Figure 3: annotated screenshot of GUI 

 

Table 1: GUI annotations and overview 

Pos. Name Annotation 

1 Menu bar Contains dropdown menus for general use cases. 

2 ECU selection Provides an overview of open ECU windows and indicates which 
one is focused. 

3 general info 
box 

Logs and informs about general events. 

4 ECU menu bar Contains dropdown menus for ECU related use cases. 

5 ECU overview General info about the ECU (firmware version and IDs), activity 
indicator, and quick access buttons. 
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6 Live View List of currently observed variables / parameters with updating 
values. Double clicking on the items to the right (pos. 9) will move 
them to the live view. Double clicking in here will remove them 
again. See chapter 11.2 Live View for more information. 

7 Live View plot Plotted Live View variables. 

8 Live View 
legend 

Color legend of the plot mentioned above. Clicking on the colored 
line icons toggles their presence in the plot. 

9 Variable 
overview 

Overview of all variables / parameters (subject to variable config). 
Double clicking on the listed items moves them to the live view 
(pos. 6). By left clicking into the value fields you can set the value. 

10 Variable info 
box 

Description of selected variables / parameters, range of valid 
values. 

11 Variable config 
selector 

Dropdown menu for selecting different variable configs. 

12 Reconnect to 
any ECU 

Checkbox that allows the window to be reused for an ECU with a 
different hardware ID, to quickly switch between different ECUs. 
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10.1 Main menu bar 

In the following Chapter, we will showcase how to access the various key features of the 
Enable-Tool. Each feature will have a small screenshot and an accompanying explanation 
what is seen. The explanation on how to use these features is explained further down in 
the chapter Key features. 

10.1.1 Start 

 

Figure 4: menu bar start 

There are four options:  

• Scan:  

Starts to scan for connected ECUs 

If it finds any, it will automatically open up a window and a corresponding entry in 
the ECU section (pos. 2). 

• Reset:  

Resets the currently opened windows to their initial settings (i.e. empty live view) 
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It also resets the link between the window and the concrete ECU connected, so 
that it can be connected to other ECUs. 

• New: 

Opens up a new empty window which automatically connects to any undiscovered 
ECUs that are connected via USB (devices connected via CAN bus can be 
discovered through the “Scan” option) 

• Exit:  

Closes the Enable-Tool 

10.1.2 Settings 

 

Figure 5: menu bar settings 

There are two options:  

• Connection Settings: 

Specifies the connection (USB/CAN) used for the communication with the ECU  

For more information see chapter 13 Connect via CAN. 
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• View:  

Specifies the window layout if multiple ECUs are connected 

The available options are stacked, vertically split or horizontal split.  

10.1.3 Tools 

 

Figure 6: menu bar tools 

• Fleet Manager Toolbox: 

A toolbox that allows managing of licenses and files relating to the ECU 

More information can be found in chapter 14.4 Fleet Management. 

• Variables Config Manager:  

Modification and creation of variable configs 

More information can be found in chapter 14.2 Variable Config Toolbox. 

• Snapshot Toolbox: 

Comparison and creation of snapshots 
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 More information can be found in chapter 14.1 Snapshot Toolbox. 

• View ECU Logfile:  

Viewing log files 

More information can be found in chapter 11.3 Logging. 

• File Encryption Toolbox:  

En-/decrypting of files 

This tool will only be available to specific partners and is hidden otherwise. 

10.1.4 Language  

 

Figure 7: menu bar language 

This menu allows selecting the language. (The available languages are currently limited to 
English, German, French, and Spanish) 
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10.1.5 Help Content 

 

Figure 8: menu bar help 

The help menu options are as follows  

• Help Content:  

Brings up this document 

• Info:  

Brings up a small box with general information about your Enable-Tool, as well as 
information about your license  

• License:  

Pulls up a context window which shows information about your license and an 
option to deactivate your license 

 See chapter 15.1 Deactivating a License for more information. 

• Download Offline Support:  

See the chapter 14.3 Offline support for more information. 
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• Download Tool Setup:  

Downloads the latest version of the Enable-Tool installer, which will be 
automatically configured to match the current version, and can be used for further 
distribution via other means 

 Update files can be found at C:\FRIWO\Enable Tool Application\Update_Files. 

• Restore Fleet Folder: 

Restores the fleet folder files in accordance to your working directory, see chapter 
14.4 Fleet Management for more information about working directories.  

• Search for Updates:  

Looks for new updates 

If any are found, the Enable-Tool will prompt with a changelog and an option to 
update it. 

• Debug Window:  

Logs debug messages 
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10.2 ECU Menu bar 

This menu bar offers ECU specific functions, tools and wizards. Some of them are also 
provided as dedicated buttons in the ECU overview for quick access using the same icons. 
Hovering over them with the cursor will also show their function. 

10.2.1 Functions 

 

Figure 9: ECU menu bar functions 

• Copy ECU ID to clipboard:  
Copies the unique ID of the ECU into the system clipboard 

• Write Snapshot:  
Opens up a file explorer window to select the snapshot to be written onto the ECU 

• Create Snapshot:  
Opens up a file explorer window to enter location and name of the snapshot that is 
going to be created of the ECU, followed by signature window to sign the snapshot 
More information can be found in chapter 11.5 Snapshots. 
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• Update ECU: 
Opens up a prompt to enter the firmware and an optional snapshot for updating 
and parametrization of the ECU 
For more information on snapshots, see the chapter 11.5 Snapshots. 

• Save On ECU: 
Save currently applied parameter changes to the ECU to start with them after 
power up 
Otherwise changes are lost after a power cycle. 

• Restart ECU: 
Force a restart of the ECU 
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10.2.2 Extras 

 

Figure 10: ECU menu bar extras 

These are the extra options 

• Logging Settings: 
 Set name, location and logging interval for the new log file 

• View ECU log file: 
Opens a file explorer window to select a recorded log file and view it in the live 
view plot 

• Snapshot Settings: 
Allows the selection of additional parameters that are transferred on top of the 
standard configuration parameters 
Which parameters are selectable depends on the license. The view is adjusted 
accordingly. 

• Create Service Ticket: 
Opens up a small form to enter a text describing the issue at hand 
There is also a history with previous reports and statistical data (if any were 
submitted). 
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• Prepare Delivery:  
Resets the error logs in the ECU and for motor controllers the mileage as well 

10.2.3 Wizzard 

 

Figure 11: ECU menu bar wizzard 

The Wizzard option is only available on motor controllers. For more information see the 
chapter 10.2.3 Wizzard. 
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10.2.4 View 

 

Figure 12: ECU menu bar views 

The view tab allows you to save and restore a set of parameters in the live view window 
using .ovp files. 
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11 Key Features 

11.1 Changing Parameters 
After the connection to an ECU has been established, all accessible parameters can be 
seen on the right hand side in the variables overview (position 9 in the annotated 
screenshot of GUI). Specific variables can be found with the help of the search bar or the 
sorting options (associated software module; alphabetically). Each line consists of two 
parts, the variable name and its current value. The values are read periodically but since 
there are a lot of them, updating all the values might take a few seconds. The next 
sections explain how to view and log specific parameters effectively. By clicking on the 
variable name, a description of the variable and its range of nominal values are shown. By 
clicking into the value field and entering a value, a command is sent to the ECU to use the 
updated value (only works for writable parameters).  

 

Figure 13: selecting variables 

The quick-action button to the right of the search text form (see Figure 13: selecting 
variables) also allows toggling the view to only see variables that were selected by double 
right clicking on them. It is sometimes helpful to have a preselected set of variables so it is 
easier to quickly view and change them which this feature facilitates. 
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11.1.1 Permanently changing Parameters 

In order to retain values written and configured during the runtime of the controller, the 
Save on ECU button in the Functions tab of the ECU menu bar (position 4 in the annotated 
screenshot of GUI) or on the corresponding quick-action button must be used. Otherwise 
the changes are lost after a power cycle. 

11.2 Live View 

 

Figure 14: live view 

In the previously mentioned variables overview a double left click on the variables will 
move them over to the live view in the middle of the screen (position 6 in the annotated 
screenshot of GUI). They can be sorted in a similar fashion to the variables overview. 
Double left clicking on variable names in the live view will remove them from the list. 
Variables displayed here are being updated more frequently, and are also visualized in the 
plot below. There is a colored legend below the plot, clicking on the colored line icon in the 
legend will toggle whether its parameter will be plotted or not. This option only affects the 
current view of the plot; it does not delete the parameter from the live view. The plot 
automatically scrolls down the time axis and only ever shows the last minute, the ordinate 
will automatically scale to include currently visible maximum and minimum. 
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The current list of variables in the live view window can be saved to restore it after 
restarting the application. This can be done via the View menu in the ECU menu bar 
(position 4 annotated screenshot of GUI) and the Save view settings… option. Now a 
descriptive name for the file can be entered. The saved view can be loaded again via the 
Load view settings… option in the same menu. 

 

 

Figure 15: diagnosis view 

Double left clicking on the plot will pop up the diagnosis window. This is a frozen version 
of the plot as it was when it was clicked. Inside the diagnosis window, a cursor (blue line) 
is available to drag to a certain point in time to inspect the exact values that have been 
recorded. 
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Several shortcuts are available to manage the plot: 

 Hold CTRL & left mouse button to scroll through the window 

 Hold CTRL & click right to undo the last action  

 Double click left anywhere to reset the view (axes are scaled to fit full plot) 

 Use the mouse wheel to zoom in or out around the current center of the plot 

 Hold shift & click left/right to zoom in/out around the current cursor position. 

 

11.3 Logging 

 

Figure 16: log settings 

The Enable-Tool also has the option to log all live viewed parameters. This can be done via 
the Logging Settings found in the Extras tab of the ECU menu bar or by using the 
according quick-action button. In the now opened pop up window, settings like the name 
of the log file, the logging interval as well as the path can be set before starting the 
logging process with the Start button. The logging interval should be set in consideration 
of the number of logged variables. In general, the number of logged variables should be 
chosen rather conservative. The data will be written into the file in csv format, which can 
be opened by most modern spreadsheet applications. The quick-action button to Start 
and Stop logging is situated to the right in the live views menu bar, it will change its 
appearance, along with the text to the side, to indicate whether it’s possible to start 
recording or it is Preparing… or Logging.  
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11.4 Variable Config 

 

Figure 17: variable config 

The variable config files determine which set of variables are initially seen in the variables 
overview. In the upper right corner on the ECU menu bar (position 4 in the annotated 
screenshot of GUI) the configuration to load must be chosen. Access to certain 
parameters can be limited depending on the role that the config is associated to, further 
information are given in chapter 15.2 Roles and permissions. It is also possible to further 
reduce the available parameters by creating a subset of the variable config, chapter 14.2 
Variable Config Toolbox provides more details. 
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11.5 Snapshots 

A snapshot freezes the configuration of an ECU at a certain time. It can be used to put an 
ECU into a known state. The common use case for this is to first configure or trim features 
of the ECU to achieve the desired behavior, then creating a snapshot of it to be able to 
bring other ECUs to the same state or to roll the ECU back after further testing. Another 
important aspect is that snapshots can be signed. Signed snapshots are used to brand the 
ECU, and contain information about access rights (see chapter 15 Licensing for more 
information). Therefore, only signed snapshots can be written back onto the ECU. This 
ensures that no one can tamper with it. This is possible because every snapshot has its 
own unique identifier, which the Enable-Tool will use to determine access rights.  
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11.5.1 Creating a snapshot 

 

Figure 18: create snapshot 

Snapshots can be generated by clicking on the Functions tab in the ECU menu bar 
(position 4 in the annotated screenshot of GUI) and selecting Create Snapshot…. 
Alternatively, there is a corresponding quick-action button in the ECU overview window 
(position 5 in the GUI overview figure) as well.  

Using either option will bring up a prompt to enter name and location of the new 
snapshot. Entering the required information will result in a second pop up that allows 
signing the created snapshot.  
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Figure 19: signing snapshot 

It is now possible to decide whether or not to sign the new snapshot. If the snapshot is to 
be signed, the three IDs, OEM ID, Client ID, Project ID need to be entered. These values 
decide which licenses have which access to the ECU. Chapter 15.2 Roles and permissions 
provides more information about that. If the snapshot is left unsigned it cannot be flashed 
onto an ECU. Snapshots can only be signed by partners and developers, more information 
on that can be found in chapter 15.3 Roles, identifiers, and descriptions. 
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11.5.2 Writing a snapshot 

 

Figure 20: write snapshot 

Existing snapshots can be written by clicking the Functions tab in the ECU menu bar 
(position 4 in the GUI overview figure) and selecting Write Snapshot…. A file explorer 
window opens up to select the snapshot file. This will in effect restore all configuration 
parameters (parameters with a C preamble) to the ECU. A warning is issued if there is a 
mismatch between the current firmware version and the one used to create the snapshot.  
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Figure 21: snapshot settings 

Extras → Snapshot settings allows you to select additional parameters to be transferred 
during writing of the snapshot. 
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11.6 Updating the ECU 

 

Figure 22: updating the ECU 

Clicking the Functions tab in the ECU menu bar (position 4 in the GUI overview figure) and 
selecting Update ECU…, or the corresponding quick-action button will bring up a window 
to flash a new firmware onto the ECU. Via the Browse button the desired firmware file can 
be selected. Additionally, a Snapshot can also be included to preset parameters right after 
the flashing procedure, which is the recommended way of updating the ECU. If the box 
Write XC Parameter from Snapshot to ECU is checked, all current parameters that have 
been assigned via teach-in method (see chapter 10.2.3 Wizzard for more information) will 
be overwritten. This is, however, not recommended unless the ECU will operate on the 
same vehicle from which the XC parameters were taken from. 

Careful! Do not to interrupt the USB connection during the update. This may cause irreversible 
damage to the ECU. 

We highly recommend only flashing ECUs with a signed snapshot if it is to be used in the 
field. This ensures the ECU is in a known good state. 
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12 Wizzard 

The Wizzard option is only available on MCUs and is an easy way to teach-in parameters 
with regard to external components such as the accelerator or the motor. By clicking on 
the Wizzard tab on the ECU menu bar (position 4 in the GUI overview figure) and then 
selecting the according external component to be calibrated, a configuration window with 
the following context and instructions will open. 
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12.1 Teach in AIN1 and AIN2 

 

Figure 23: teach in AINx 

1. Operate the pedal, throttle grip or potentiometer as far as it will go. (Calibration)  

2. Bring the pedal back to the initial position.  

3. Apply the pedal again as far as it will go (check). 
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12.2 Teach in motor 

 

Figure 24: teach in motor 

1. Ensure that the motor can run freely and unobstructed. No load should be applied! 

2.  Enter the correct Motor specification in the fields seen in Fehler! Verweisquelle konnte 
nicht gefunden werden.. 

3. Press the start button. 
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13 Connect via CAN 

 

Figure 25: connect via CAN interface 

Connecting to the ECU via CAN requires a CAN Adapter. The driver for the CAN Adapter 
has to be installed and up to date. After connecting the ECU with the CAN Adapter to the 
PC, the connection settings has to be changed as well. This can be done via Connection 
Settings… in the Settings tab. In the lower half of the prompt are several options relating 
the CAN interface, which have already been set to the ECUs default parameters. Once the 
interface has been initialized, available ECUs can be searched. If the desired device was 
found and the prompt was closed with the OK button, the usual ECU configuration 
window appears. 

Different interfaces can be selected in case multiple CAN adapters are connected. The 
other settings only need changing if they were changed on the ECU beforehand. 

Currently supported CAN Adapters: PEAK CAN 
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14 Toolboxes 

14.1 Snapshot Toolbox 

 

Figure 26: snapshot toolbox 

As described before, a snapshot is a list of all the parameters in the ECU from the time the 
snapshot was taken. The Snapshot Toolbox can be found under the Tool tab in the main 
menu bar. It allows comparing and editing different snapshots. These snapshots could be 
old snapshots from files, or directly downloaded from the currently connected ECUs. At 
first the variable config, which was used to create the snapshot, needs to be selected in 
the top of the window. After that there are two choices. Either a snapshot is loaded from a 
file or from a connected ECU. Loading from the ECU will not immediately create a 
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snapshot of it, nor are changes made to a loaded ECU parameter set persistent. After 
loading both, visibility of either all variables, or the ones that differ between the 
snapshots, can be set by marking the appropriate check boxes. Values on the left side can 
be edited by left clicking into the text field and entering the new value. If the snapshot on 
the left is not loaded from an ECU, a new custom snapshot can be created with the 
changed values. If the left hand side snapshot is a currently connected ECU, changes will 
be written to the ECU immediately. The parameters will be colorized to indicate the status 
of the comparison. Right clicking onto the parameter name will transfer the value from 
the right hand side to the left hand side, if the Left side editing box is ticked. By using the 
Save left side button the snapshot can either be saved to ECU persistent (only if it was 
previously loaded from the ECU), or be saved to file. When saving to file the create 
signature prompt will open up. Only signed snapshots can later be written to an ECU. It 
also keeps track of the IDs. For more information about IDs see chapter 15 Licensing. 
After signing the snapshot, the location and name of the new snapshot needs to be 
entered in order to save the snapshot file. 
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14.2 Variable Config Toolbox 

 

Figure 27: variable config toolbox window 

With the variable config toolbox, new subsets of currently available variable configs can be 
created. The Variable config toolbox is available through the Tool tab on the main menu 
bar. Upon opening the toolbox window two variable views are visible. The one on the left 
hand side shows the variables in the currently selected variable config. The one on the 
right hand side shows the selected variables that will end up in the new config. The 
available configs will be listed in the dropdown menu below the left hand view. It is also 
possible to change roles to further limit access to these variables. However, only roles 
with the same permission, as the current config, or lower are available. It is not possible to 
inter mix config variables from battery management units and motor control units.  
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If a config is not located in the default path, it can be loaded using the Load… button to the 
bottom left hand side of the window. Configs located in the default location will be loaded 
automatically. Clicking the Reset button will clear the list of variables in the right hand side 
view of the variables. The newly created config can be saved after entering the OEMs ID, 
client ID and project ID via the Save as… button to the bottom right of the window. For 
more information about the various IDs, see the chapter 15 Licensing. 
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14.3 Offline support 

 

Figure 28: offline support download progress 

To be able to communicate with the ECU a description file that corresponds to the 
firmware version on the ECU is needed. Usually, the Enable Tool will go ahead and 
automatically download this file once it sees a new ECU. However, all description files can 
be loaded ahead in case working in environments without a working internet connection is 
required. The Download offline support… in the Help tab of the main menu bar provides 
this feature. In the upcoming prompt, clicking Load will start the download of all 
description files. The download may take a while, and upon being exited, will continue 
where it left of the next time the download is resumed. As the tool is not meant to 
operate offline all the time, there is a timer on how long offline operation is permitted, 
which is currently 45 days. After this period the Enable-Tool needs to be connected to the 
internet again to verify licenses and check for updates. 
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14.4 Fleet Management 

 

Figure 29: fleet manager toolbox window 

 This is the Fleet Manager Toolbox window, it is only accessible to people who are 
registered as fleet managers for the project code (license pool) of their license. The fleet 
manager can turn files, snapshots and firmware updates into packages and distribute 
them via working directories, as well as activate and deactivate individual licenses. Every 
user is assigned a working directory so this way the fleet data can be managed, so that 
every end user of the Enable-Tool has exactly what they need. 
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Fleet managers can also promote other Licenses to fleet manager. If there is no current 
fleet manager, which will be the case after the initial license purchase, a request needs to 
be issued to software.support@friwo.com containing the following information of the 
fleet manager: 

 Name 

 Unique ID of the license (Help → Info…) 

 E-mail 

 Phone number (optional) 

If that person is not the person responsible for the purchase of the license, we kindly ask 
that the responsible person be put into cc when making the request, so that they are 
informed about it. We will then go ahead and confirm this request with them, and then 
promote the given license identified via the unique ID to fleet manager.  
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Figure 30: fleet manager set working directory 

The fleet manager is available via the Tools tab on the main menu bar by selecting Fleet 
Manager Toolbox. The fleet manager keeps track of the files relating to their Vehicles 
(hardware description, firmware or documentation etc.) as well as manages access rights 
to them. The files are arranged in so called working directories, those working directories 
represent a set of files that can be used to distribute to specific users (identified via their 
licenses unique ID) or an entire license pool (identified via the project code). They can be 
used to manage access rights of e.g. different branches of operations (production and 
service technicians as two examples) see chapter 15.2 Roles and permissions for more 
information. Those working directories determine who in the license pool gets access to 
which files. After the working directory has been created, the license pool can be set up by 
right-clicking on the pool you want to set up in the Manageable License Pools view of the 
Fleet Manager and selecting the desired option on the Set Working Directory tab. 
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Figure 31: fleet manager context menu licenses 

Fleet managers are also able to manage individual user licenses. They can promote other 
licenses to fleet manager, as well as activate and deactivate licenses that are registered to 
the project code. Fleet managers will also be informed via E-Mail about any changing 
license status, such as a user activating their license, or if purchased licenses are about to 
expire. 
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Figure 32: fleet manager working directory overview 

Clicking on Manage Working Directory will open a prompt that allows you to add new 
working directories. There are two options to fill the working directory to be created with 
files. Download will pull the selected files from existing working directories to the 
preliminary working directory (bottom right context window). Add pushes selected local 
files into the preliminary working directory. Upload will then push the local preliminary 
working directory to the server where it will be stored under the given name. Since it is 
not possible to change the working directory once it’s pushed to the server we 
recommend to double check the files before uploading.  
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Figure 33: updating files in working directories 

New working directories can be created using the update function. To do that, simply 
choose the fleet that requires a new working directory, and give it a name. Now there will 
be a new working directory with the contents previously chosen in the Upload context. 
After the fleet manager created the new working directory and assigned it to a certain 
license, the end users of the Enable-Tool application can now pull in changes by selecting 
the Search for Updates in the Help tab on the main menu bar. Alternatively restarting the 
Enable-Tool application will update the files, if the internet is accessible. A prompt will pop 
up with the release notes and ask to confirm the update. This will synchronize the 
contents of the RemoteFleetData directory with the data in the working directory which is 
assigned to that user.   

FRIWO   ENABLE TOOL

 53/60



 

Enable-Tool 
Manual 

 

 

15.12.2021  54|60 

 

Confidential 

15 Licensing 

Licenses are arranged in license pools, which are identified by the project code. When 
ordering new licenses through our online shop, the project code to which the licenses will 
be added has to be specified. For new customers that don’t have a project code, please 
enter “new”. If the project code is lost or forgotten, please send an inquiry to 
feedback@friwo.com Please state your name, E-Mail, and if possible, your unique license 
ID. A valid project code has to be entered to request a license through the Enable-Tool. 
The license to be received is not directly issued by FRIWO but is part of the license pool 
which the project code refers to, and which a client has previously bought. To receive a 
project code, please contact the OEM of the ECU. The license is then registered to your 
name, and bound to your workstation. 
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15.1 Deactivating a License 

 

There are two ways in which to deactivate a license. The fleet manager can deactivate 
each license in the license pool that they govern. A user might also deactivate their license 
by clicking on Help → License, and then clicking the button on the bottom left corner of 
the prompt. 
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15.2 Roles and permissions 

The ECUs can be identified via three identifiers which are explained in the following 
sections and are relevant for access rights and permissions with regards to the firmware 
running on the ECUs 

OEM ID: 

This identifies the manufacturer of the ECU. OEM IDs uniquely identify partners of FRIWO 
that are utilizing our firmware. 

CLIENT ID: 

This identifies the client of the OEM. Clients are system integrators who wish to integrate 
our ECUs into their products. Client IDs are only unique in the context of an OEM. A client 
can have different IDs at different OEMs. For example a company could be a client of 
FRIWO, purchasing Motor control units, and obtain battery management systems from 
another OEM. In this case the company is a client of both parties and thus has an ID at 
both, which may or may not be the same. 

PROJECT ID: 

This is an ID which a client can set themselves to identify their products. They can use 
different IDs to distinguish different products, and thus have a fine grained control over 
who gets permissions to access which of their products. 

 

The Enable-Tool is able to reproduce these IDs from the ECU and uses the following roles 
decide which parameters and to what extend the user might have access to. Access will 
also be allowed or restricted based on the variable config that is selected. 
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15.3 Roles, identifiers, and descriptions 
Table 2: user role description 

Number Role Description 

123 Partner  Partners of FRIWO who build their own hardware but pair it with 
FRIWO’s licensed software 

100 Developer Customers who buy hardware and software from FRIWO and only 
do configuration 

1 Service Service and maintenance technicians who don’t configure 
something themselves and only read out data, or load 
preconfigured configs 

Now whether or not access is granted to a specific ECU or not will depend on the following 
settings. A user can have multiple Roles for multiple products. The final access 
permissions look like this: 

 User:   ROLE – OEM ID – CLIENT ID – PROJECT ID 

 Example: 

 John Doe: 1 – 1 – 99998 – 3 

   100 – 1 – 99999 - * 

The user John Doe now has two roles for two different clients. He would be a service 
technician for the client whose ID is 99998 and a developer at client 99999. For his role as 
service technician he only has permissions for the project whose ID is 3. The asterisk 
indicates that the role is applicable over the entire range of valid IDs in that category. The 
exact read and write permissions, as well as which functions are available for which role is 
shown in Table 3: permissions.  
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So to recap, the check for access rights looks like this. 

 

First the Enable-Tool identifies the connected ECU via the OEM ID, the CLIENT ID and the 
PROJECT ID, which have been branded into the ECU during the creation of the snapshot 
and subsequent flashing of said snapshot onto the ECU. Then the Enable-Tool checks the 
selected variable config to ascertain which parameters can be accessed. It is possible to 
alter the access rights, by switching the variable config. However, the Enable-Tool won’t 
allow anyone to select a variable config that exceeds the permissions of their license. The 
Enable-Tool will disregard any variable config that exceeds the user’s permissions. So 
they won’t be visible in the Enable-Tool. 

The default permissions with a license obtained through our web shop grants the role of 
developer for all FRIWO ECUs, a client can flash their own snapshot with their CLIENT ID 
to brand it as their own ECU and thus prevent others with default permissions from 
accessing their ECU. 

 

It should be noted that the only effective difference between a service and a developer 
role lie within the fact that the service role cannot alter or create signed snapshots, so 
they cannot alter the ECU parameters in a persistent manner. They can, however, alter the 
live parameters that are configured (by the developer) in the variable configs that they got 
access to.  
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15.4 Permissions 
Table 3: permissions 

Permission Service Developer Partner 

Establish connection with the control unit (e.g. read out 
error memory) 

1 3 5 

Perform firmware update    
Transfer signed snapshots to ECU    
Create signed snapshots from ECU    
Transfer snapshot to different vehicle model (change 
project ID) 

   

Sign snapshot for all vehicle models of a manufacturer    
Sign snapshots for all their clients   6 
Snapshot without signature (for collaboration with 
development) 

   

Manual data change 2 4 7 
Manual storage of data changes    
Record log data    
Licensing of produced ECU hardware    

1. individual vehicles only 

2. only visible parameters 

3. all vehicle types 

4. application-specific parameters 

5. all models, all manufacturers 

6. A partner can sign snapshots for all their customers, not those of other partners 

7. all parameters 
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16 Bug reporting 

If you encounter any unexpected behavior, we appreciate it if you could take a moment of 
your time to answer the following questions, if possible, and send them, as well as any 
session log file or relevant screenshot as contact form or via mail to feedback@friwo.com. 

You can find the session log files at “C:\FRIWO\Enable Tool Application\EtLogs” 

Questions: 

1. Summary of the bug. 
2. Steps to reproduce. 
3. What is the current bug behavior? 
4. What is the expected correct behavior? 

Final Words 

You’ve reached the end of the Manual, thank you for your time and attention. This Manual 
should have given you the insight required to smoothly and efficiently use the Enable-
Tool. 

Feedback 

We are working very hard to improve our products and therefore feedback is 
indispensable! Please send us your valuable feedback as contact form or via Mail 
to feedback@friwo.com

https://friwo.link/et/feedback

https://friwo.link/et/feedback
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